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Chapter 12 Object-Based Programming
Visual Basic.Net 2/e


Multiple Choice

1. All of the following are examples of objects except:

a) controls.

b) properties.

c) forms.

d) StreamReader


Answer:
X
Section Reference:
Introduction

2. Code and data of an object are insulated from other programs.  This is referred to as:

a) instantiation.

b) isolation.

c) encapsulation.

d) polymorphism.


Answer:
X
Section Reference:
Section 12.1

3. A code template that defines the characteristics of an object is a(n):

a) module.

b) instance.

c) event.

d) class.


Answer:
X
Section Reference:
Section 12.1

4. Methods and properties are collectively recognized as class:

a) members.

b) events.

c) objects.

d) instances.


Answer:
X
Section Reference:
Section 12.1

5. The characteristic of a class that allows another class to extend its methods and properties is:

a) encapsulation.

b) instantiation.

c) inheritance.

d) polymorphism.


Answer:
X
Section Reference:
Section 12.1

6. All of the following are advantages of building classes and using objects except:

a) code reusability.

b) easy maintainability.

c) more flexible data validation rules.

d) easier project management.


Answer:
X
Section Reference:
Section 12.1

Class members that cannot be instantiated are recognized as:

a) class members.

b) inheritable members.

c) instance members.

d) static members.


Answer:
X
Section Reference:
Section 12.1

7. Class members that can be instantiated are recognized as:

a) class members.

b) inheritable members.

c) instance members.

d) static members.


Answer:
X
Section Reference:
Section 12.1

8. A class module behaves like:

a) the visual elements of a form.

b) the visual elements of a standard module.

c) a standard module.

d) the code window of a form.


Answer:
X
Section Reference:
Section 12.2

9. A class is created by writing code in a(n):

a) garbage collector.

b) class module.

c) event handler.

d) standard module


Answer:
X
Section Reference:
Section 12.2

10. An important distinction between class modules and standard modules is:

a) class modules contain visual elements, while standard modules do not.

b) standard modules contain visual elements, while standard modules do not.

c) there can only be one copy of a standard module in a project, but there can be as many copies of a class module as there are instances of the class.

d) there can only be one copy of a class module in a project, but there can be as many copies of a standard module as there are instances of the module.


Answer:
X
Section Reference:
Section 12.2

11. Given an object named objStudent, the correct syntax to destroy the object is:

a) objStudent.Destroy.

b) objStudent.Delete.

c) Set objStudent = Destroy.

d) Set objStudent = Nothing.


Answer:
X
Section Reference:
Section 12.2

Given an object named objStudent that is an instance of clsStudent, with a method named CalcGPA, the correct syntax to invoke the CalcGPA method is:

a) clsStudent.CalcGPA.

b) objStudent.CalcGPA.

c) CalcGPA.

d) clsStudent.objStudent.CalcGPA.


Answer:
X
Section Reference:
Section 12.2

12. An important distinction between class modules and standard modules is:

a) a class module exists during the life of the project, while a standard module exists when it is called from a procedure.

b) a standard module exists during the life of the project, while an object exists from the time it is created from the class module until it is destroyed.
c) public procedures in the class module can be called by simply calling the procedure name, while public procedures in the standard module must be referenced with the module name.

d) with class modules, there can only be one copy of a public procedure in the project, while with standard modules, there can be as many copies of the procedure as there are forms or modules that call that procedure.


Answer:
X
Section Reference:
Section 12.2

13. Given an object named MyStudent, which is an instance of a class named Student, the correct way to refer to a public variable of the object named StudentID is:

a) StudentID.

b) Student.StudentID.

c) Student(StudentID).

d) MyStudent.StudentID.


Answer:
X
Section Reference:
Section 12.2

14. If an object is created with an object variable in a procedure, the object is destroyed:

a) when the procedure ends.

b) when the next copy of that object is created.

c) when the project ends.

d) when the garbage collector is invoked.


Answer:
X
Section Reference:
Section 12.2

15. The first line of a Public class named Student is:

a) Class Student.

b) Public Student.

c) Public Class Student.

d) Public Sub Student.


Answer:
X
Section Reference:
Section 12.2

16. To add a class module to a project:

a) select Add Class from the Project menu.

b) select Add File from the Project menu.

c) select Add Class from the File menu.

d) type the statement Class in a form module.


Answer:
X
Section Reference:
Section 12.2

Public variables in a class are exposed as:

a) properties of the class.

b) methods of the class.

c) events of the class.

d) constructors of the class.


Answer:
X
Section Reference:
Section 12.2

17. Public procedures in a class are exposed externally as:

a) properties of the class.

b) methods of the class.

c) events of the class.

d) constructors of the class.


Answer:
X
Section Reference:
Section 12.2

18. Public variables in a class module exist:

a) throughout the life of the project.

b) until another object is instantiated from the same class.

c) until the object created from the class is destroyed.

d) until the computer is shut down.


Answer:
X
Section Reference:
Section 12.2

19. To make a class accessible only to the modules in the current project, declare it with the:

a) Public keyword.

b) Friend keyword.

c) Private keyword.

d) Shared keyword.


Answer:
X
Section Reference:
Section 12.2

20. The procedure that is used to return the value of a property is:

a) Get.

b) Set.

c) Return.

d) Value.


Answer:
X
Section Reference:
Section 12.2

21. The correct syntax to create a property called Name that returns a string is:

a) Property Name().

b) Name() as String.

c) Property Name() as String.

d) Public Property Name() as String.


Answer:
X
Section Reference:
Section 12.2

22. Given a class named Student of a Long type, the correct syntax to create an instance of Student and assign it to a variable named MyStudent is:

a) Dim MyStudent as Long().

b) Dim MyStudent as New Student().

c) Dim MyStudent as Student().

d) Dim MyStudent = Student().


Answer:
X
Section Reference:
Section 12.2

23. An important distinction between static members and instance members of a class is:

a) static members can be referenced by either class name or by object name while instance members can only be referenced by object name.

b) static members can be referenced by either class name or by object name while instance members can only be referenced by class name.

c) instance members can be referenced by either class name or by object name while static members can only be referenced by object name.

d) instance members can be referenced by either class name or by object name while static members can only be referenced by class name.


Answer:
X
Section Reference:
Section 12.2

24. Given a class named Student, with a property named StudentID, and an instance of that class named MyStudent, the correct syntax to set the StudentID property of MyStudent to a local variable named ID is:

a) Set StudentID = ID.

b) Student.StudentID = ID.

c) MyStudent.StudentID = ID.

d) MyStudent.ID = StudentID.


Answer:
X
Section Reference:
Section 12.2

25. To invoke an instance method of a class:

a) you must reference the method with the class name.

b) you must reference the method with the object name.

c) you may reference the method with either the class name or the object name.

d) you must reference the method with the class name first, then the object name.


Answer:
X
Section Reference:
Section 12.2

26. Given a class named Student with a constructor that specifies a parameter named ID, the correct syntax to create an instance of that class named MyStudent and pass the value of a variable named StudentID is:

a) MyStudent = Student(StudentID).

b) Dim MyStudent as Student(ID).

c) Dim MyStudent as New Student(StudentID).

d) Dim MyStudent = Student(StudentID).


Answer:
X
Section Reference:
Section 12.2

27. To declare a property in such a way that code cannot set the value for that property, declare it with the:

a) ReadOnly specification.

b) WriteOnly specification.

c) Public specification.

d) Friend modifier.


Answer:
X
Section Reference:
Section 12.2

28. Given a class named Student, with a static method named CheckParkingTickets, and an instance of the class named MyStudent, the correct syntax to invoke the CheckParkingTickets method is:

a) CheckParkingTickets.

b) MyStudent. CheckParkingTickets.

c) Student. CheckParkingTickets.

d) either B or C


Answer:
X
Section Reference:
Section 12.2

In general, the potential for data contamination in a class module is:

a) greater than in a standard module.

b) less than in a standard module.

c) the same as in a standard module.

d) impossible.


Answer:
X
Section Reference:
Section 12.2

29. The procedure that is often used to set the initial states for an object is the:

a) instantiator.

b) encapsulator.

c) constructor.

d) AddHandler.


Answer:
X
Section Reference:
Section 12.2

30. The procedure that is automatically executed when an object is created from a class is:

a) New().

b) Main().

c) Event().

d) Instance().


Answer:
X
Section Reference:
Section 12.2

31. Given a class named Student, the correct syntax to create a private enumerated constant named AcadLevel with five possible values is:

a) AcadLevel.

b) Enum AcadLevel(5).

c) Private Enum AcadLevel(5).

d) Private Enum AcadLevel.


Answer:
X
Section Reference:
Section 12.3

32. Given a class named Student, with a property named Level which is set to an enumerated constant named AcadLevel, and an object named MyStudent, the correct syntax to define MyStudent as a sophomore is:

a) MyStudent = Student.AcadLevel.

b) MyStudent.Level = Sophomore.

c) MyStudent.Level = Student.AcadLevel.Sophomore.

d) MyStudent.AcadLevel = Sophomore.


Answer:
X
Section Reference:
Section 12.3

33. Given a class named Student, the correct syntax to declare an event called Graduate that requires two parameters, GPA of type double and Major of type string is:

a) RaiseEvent (Graduate).

b) Public Event Graduate(GPA as double, Major as String).

c) RaiseEvent Graduate(GPA,Major)

d) Event Graduate.GPA.Major.


Answer:
X
Section Reference:
Section 12.3

Given a class named Student with an event named Graduate that requires two parameters, GPA and Major, the correct syntax to fire the event and pass variables named MyGPA and MyMajor is:

a) FireEvent Graduate(GPA,Major).

b) RaiseEvent Graduate(GPA,Major).

c) RaiseEvent Graduate.GPA.Major.

d) RaiseEvent Graduate(MyGPA, MyMajor).


Answer:
X
Section Reference:
Section 12.3

34. The statement that can be used to hook an event with its handler at runtime is:

a) AddHandler.

b) Handles.

c) Handler.

d) Hook.


Answer:
X
Section Reference:
Section 12.3

35. A class can contain one or more other events, forming a class of:

a) inner classes.

b) outer classes.

c) nested classes.

d) join classes.


Answer:
X
Section Reference:  Section 12.4

Fill in the Blank

36. A(n) ____________ is a code template that defines the characteristics of an object.


Answer:
Xlass
Section Reference:
Section 12.1

37. A(n) __________________ is instantiated from a class.


Answer:
Xbject
Section Reference:
Section 12.1

38. A(n) _________________ class allows another class to extend its methods and properties.


Answer:
Xnheritable
Section Reference:
Section 12.1

39. The _____________________ is used to reclaim the resources that an object used.


Answer:
Xarbage collector
Section Reference:
Section 12.2

40. Public variables of a class module must be referenced with the ________________ as the qualifier.


Answer:
Xbject name
Section Reference:
Section 12.2

41. Public variables in a class are recognized as __________________ of the object.


Answer:
Xroperties
Section Reference:
Section 12.2

42. An object can be destroyed by setting it to __________________.


Answer:
Xothing
Section Reference:
Section 12.2

43. An object can be ______________________ by setting it to Nothing.


Answer:
Xestroyed
Section Reference:  Section 12.2

44. A _______________________________ can be thought of as a form module without its visual interface.


Answer:
Xlass module
Section Reference:
Section 12.2

45. ___________________ members can be referenced by either the class name or the object name.


Answer:
Xtatic
Section Reference:
Section 12.2

46. Static members are declared with the __________________ keyword.


Answer:
Xhared
Section Reference:
Section 12.2

47. In general, a class is declared with the _____________________ modifier.


Answer:
Xublic
Section Reference:
Section 12.2

48. The ________________ procedure is used to set the value of a property.


Answer:
Xet
Section Reference:
Section 12.2

49. An instance of a class must be declared with the ________________ keyword.


Answer:
Xew
Section Reference:
Section 12.2

50. Given a class named Student, with a property of StudentID and an instance of that class named MyStudent, the correct syntax to set the value of the StudentID property to 23456 is:


Answer:
XyStudent.StudentID = 23456
Section Reference:
Section 12.2

51. Another term for the New procedure is the __________________.


Answer:
Xonstructor
Section Reference:
Section 12.2

52. The _________________ statement is used to create enumerated constants.


Answer:
Xnum
Section Reference:
Section 12.3

53. The __________________ statement is used to fire an event and trigger the event procedure.


Answer:
XaiseEvent
Section Reference:
Section 12.3

54. The __________________ clause indicates which event(s) an event procedure handles.


Answer:
Xandles
Section Reference:
Section 12.3

55. In a nested class, inner classes are typically exposed as ____________________ of outer classes.


Answer:
Xroperties
Section Reference:
Section 12.4

Matching

	61.
	New
	a.
	a statement that is used to give constants meaningful names

	62.
	AddHandler
	b.
	the keyword used to declare a static member

	63.
	Encapsulation
	c.
	another name for the Sub New procedure of a class

	64.
	Inheritance
	d.
	an instance of a class

	65.
	Constructor
	e.
	the way public procedures of a class are recognized 

	66.
	Static
	f.
	used to hook an event with its handler at runtime

	67.
	Garbage collector
	g.
	methods and properties of a class

	68.
	New()
	h.
	the statement that will fire a class event and trigger the event handler

	69.
	Class
	i.
	class members that can be instantiated 

	70.
	Properties
	j.
	the value used to destroy an object

	71.
	Members
	k.
	the feature that isolates internal code and data of an object from other programs

	72.
	Form
	l.
	used to reclaim resources used by destroyed objects

	73.
	Shared
	m.
	the procedure in a class that is executed when an object is created

	74.
	Methods
	n.
	the feature that allows a class to extend the methods and properties of another class

	75.
	Object
	o.
	a class with visual elements

	76.
	Handles clause
	p.
	class members that are not instantiated 

	77.
	Enum
	q.
	the keyword used to create an object

	78.
	Instance
	r.
	used at design time to specify which event(s) an event procedure handles

	79.
	RaiseEvent
	s.
	the way public class variables are recognized

	80.
	Nothing
	t.
	a code template that defines the characteristics of an object


	Matching Answers

	61
	q
	62
	f
	63
	k

	64
	n
	65
	c
	66
	p

	67
	l
	68
	m
	69
	t

	70
	s
	71
	g
	72
	o

	73
	b
	74
	e
	75
	d

	76
	r
	77
	a
	78
	i

	79
	h
	80
	j
	
	


